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Quick Start Tip: Before you continue reading this document: Be sure to have a look at the Story Map Shortlist
section of the Esri Story Maps website if you've not already been there. It includes an overview of the Story Map
Shortlist, a gallery of great examples, and a tutorial that outlines the steps for making a Shortlist. Read that
first before continuing with this document. You may find you can get your Shortlist up and running just by
reading that. Then come back here to this document if you need to.



http://storymaps.arcgis.com/en/app-list/shortlist
http://storymaps.arcgis.com/en/app-list/shortlist
http://storymaps.arcgis.com/
http://storymaps.arcgis.com/en/app-list/shortlist/tutorial/

What's new in the latest version of the Shortlist

Welcome to version 1.4 of the Story Map Shortlist®™ application template. Read this section if you are already
familiar with the Story Map Shortlist and want to find out what's new. Otherwise you can skip to the next section.

Enhancements

The key enhancements in this release make it easier to create and manage the data used in your Shortlist and also
opens up more possibilities for automating the generation of Shortlist content from GIS databases:

e The Shortlist now supports feature services for the point layers used to define the Shortlist tabs. You can also
use feature service layers for supporting clickable point, line, or polygon layers. Previously only shapefiles or
CSV-file based layers were supported for tabs and clickable supporting layers. Feature services published with
ArcGIS Online and ArcGIS for Server are supported. Support for feature services makes it much easier to
publish a Shortlist from points you assemble in ArcMap or ArcGIS Pro and to maintain Shortlist data
dynamically. Previously you had to either export your points as a CSV file after first adding Lat and Long fields
into its attribute table, or save them as a shapefile (at which point the 254 character maximum for text fields
kicked in which could truncate your descriptions). Note: in order to use feature services to define the tabs in a
Shortlist, don't apply a scale visibility range to those layers in your web map.

e The Shortlist now supports up to 200 places per tab. Previously the limit was 99. This was a frequent request
from authors. For usability and performance reasons we don't recommend having 200 places in a tab - it may
be better to separate that many places into two or more different tabs. But if you want to have more than 99
in one tab, you can now.

e You now have the option to define all the tabs in a Shortlist with a single point layer. Previously every tab had
to be defined using a different point layer. While using one layer per tab is still supported, the option to
define all the tabs using one layer can simplify creating and maintaining Shortlists because you can assemble
all your points of interest in a single dataset.

With this option the Shortlist uses the value of a field called TAB_NAME in the point layer to determine the
name of the tab each place will belong to. This makes it easy to move places between different tabs because
instead of having to delete the place from one layer and add it into another layer you can simply edit its
TAB_NAME value. The order in which the names in the TAB_NAME field occur in the table also determines the
order of the tabs in your Shortlist.

When the Shortlist launches, if it finds a point layer in the web map containing a TAB_NAME field, it will use
that point layer to define all your tabs. Although the Shortlist gets the names of the tabs from the TAB_NAME
field, we also provide a new configuration variable that lets you specify aliases for your TAB_NAME values. In
this way you can change the names of your tabs without having to edit your data source. Similarly, a new
configuration variable also lets you change the order of the tabs you have defined via the TAB_NAME values,
so you can easily change the tab order without having to modify your source table.

e The Shortlist now automatically numbers the places in your tab(s) based on the record order in the attribute
table of the layers that define the tabs. Previously the Shortlist required a NUMBER field to be present in
those layers and it used the value of that field as the number. This made it hard to maintain Shortlists because
if you added or deleted places, you would have to update the NUMBER field for the remaining places to keep
them sequential. With this enhancement you can just add or delete places and all the remaining places in
your tab will be renumbered. This also matches the way that the Story Map Tour application numbers the
points in a tour based on a layer you provide.



The NUMBER field is no longer required. However it is still supported. If the Shortlist finds a NUMBER field in a
layer that defines a tab, it will use that field to number the places instead of automatically numbering the
places based on the record order of the records in the attribute table of the layer. This is to ensure that the
numbering in your existing Shortlists won't change if you upgrade them to this updated version. It also
provides a way to control the numbering via a field if you want to do that (for example if you want to
automate the maintenance of your Shortlist) instead of sorting or reordering the records to change the
numbering.

If you want to take advantage of the automatic numbering in this version of the Shortlist, delete or rename
the NUMBER field in the layers that define your tab(s). This will make the Shortlist use the order of the
records in your attribute table for the numbering. If your records are not in the order you want, you should
sort the attribute table on the NUMBER field first before you delete that field. This operation will involve
reloading the data into your web map.

Tip: Even if you let the Shortlist auto-number your places based on the record order in the table, it can still be
useful to keep a numeric field in your attribute table that stores the sequential record order of your places. In
this way you can edit this field and then sort the table on the field in order to change the numbering of your
places. Use a name other than NUMBER for that numeric field.

The Shortlist now supports CSV layers added to a web map via URLs to define the tabs in the Shortlist. This
lets you put one or more CSV files at any location on the web, add those files to your web map in ArcGIS
Online via their URLs instead of uploading them, and then update the files at their web location to update
your Shortlist without having to manually make any edits in your web map. So like support for feature
services, this enhancement is another way to deploy Shortlist content dynamically. The easiest way to deploy
a Shortlist this way is to put the CSV files that you will reference from your web map on the same server on
which you will be hosting your downloaded Shortlist application code. Note: If the CSV layer(s) in your web
map reference files via URLs that are not on the same server as your Shortlist, you have to specify the
DEFAULT_PROXY_URL variable in the configuration section of the Shortlist Index.html. This enables your
Shortlist to reference CSV files by URLs at other web locations, including sources like Google Docs tables
accessed in CSV format.

To improve compatibility with the data schema used by the Story Map Tour application template, the Shortlist
schema now accepts these alternative field names. (There's no need to update your existing data: all your
current field names are still supported):

- NAME can be used instead of TITLE
- DESCRIPTION or CAPTION can be used instead of DESC1
- PIC_URL, THUMB_URL, or PICTURE can be used instead of IMAGE_URL

These standardized field names are now being used for the data in the Shortlist Samples folder.

This enhancement makes it easier to define content that can be used in either the Story Map Tour or Story
Map Shortlist. If you add an additional field into your Shortlist data that stores the large image for each place
required by the Map Tour, it is possible to use the same point layer to both define one or more tabs in a
Shortlist and to define a Map Tour. The images you use in the Shortlist can be used as the thumbnail images in
the Map Tour's carousel.



Other enhancements:

The Shortlist now supports web maps and layers that are not shared publicly. If you make a Shortlist pointing
at a web map that is not shared publicly, or that contains a layer that is not shared publicly, it will prompt the
user to login with their ArcGIS Online account in order to open the web map and its content. This enables you
to create a Shortlist containing data that can't be accessed publicly so that only members of your ArcGIS
Online Organization can view it. It also enables you to test your Shortlist privately before you share your web
map to a wider audience.

The Shortlist now supports web maps and layers created with Portal for ArcGIS. Portal for ArcGIS enables an
enterprise to set up its own cloud-based mapping infrastructure, providing the same capabilities as ArcGIS
Online hosted on the enterprise's own servers rather than in Esri's cloud. Web maps created on your
enterprise portal can now be used in a Shortlist, whether your map is accessible just within your enterprise,
publicly, or to signed-in members of your Portal. To configure a Shortlist to use a web map on a portal you
have to specify the DEFAULT _SHARING_URL variable in the configuration section of the Shortlist Index.html to
match the domain URL of your portal.

We have added built-in support for black numbered marker symbols. So the COLOR_ORDER variable in the
Index.html now supports "black".

You can now include HTML tags in the descriptive text fields in your Shortlist lists in order to customize the
appearance of that text in the popups and Details panel. You can add link breaks, ruler lines, change font size
and color, etc, by adding standard HTML tags into the text fields for your Shortlist features. For example, the
following HTML tags:

A really amazing bakery and cafe.<br><hr>Neighborhood: <b>Little Italy</b><br>
<font size="'1"' color="Grey'><i>1430 Union Street between Ash and Beech</i></font>

were included in the text field shown under the image to get this formatting in the Shortlist popup

Extraordinary Desserts X

A really amazing bakery and cafe.

: Neighborhood: Little Italy

1430 Union Street between Ash and Beech

Website

The Shortlist now displays labels defined in your web map for supporting layers. Previously it did not display
labels defined for these layers. The Shortlist doesn't display labels defined for point layers that define the tabs
in a Shortlist.



e Improved support for US Federal Section 508 accessibility requirements. Users can use the TAB key to
navigate through the user interface and access each element of the story.

e You have the option to install the Shortlist application and use that one installation for multiple Shortlists by
taking advantage of the ability to pass configuration variables, such as the web map ID, color order,
details_panel. etc as parameters in the URL used to call your Shortlist, overriding the configuration variables
specified in the Index.html file. This is convenient because you can customize and install the Shortlist once,
such as with your agency's logo and color scheme, and then use that one installation for multiple Shortlists. In
order for the Shortlist to accept a web map ID via the webmap URL parameter, the ArcGIS Online account
name of the owner of the web map must be specified in the new AUTHORIZED_OWNERS configuration
variable in Index.html. If that variable is left blank, your Shortlist won't accept a webmap ID via the URL and it
will only use the webmap specified in the WEBMAP_ID variable in the Index.html file.

e We have standardized the filenames of the numbered marker symbols. All the numbered marker symbols
now use the filename convention NumberlconAXXX.png where A = the first letter of the marker's color and X
=the number it represents.

e Shortcut: In the Details panel, end users now can click the photo to launch the website referenced in the
WEBSITE field (if that field is present and populated) instead of clicking the Website link.

Main bug fixes
e The place name in the title of the popup can no longer collide with the popup's Close control (the 'X' control).

e If the Shortlist can't access the web map we now provide a message. Similarly if the web map exists but
doesn't contain any correctly formatted point layers to define the Shortlist tabs, we now provide a message.
Previously the Shortlist would hang in loading mode and not give users a message in both of those cases.

e If your subtitle doesn't fit in the available space, we now provide a scroll bar to the right of it so people can
scroll through it. Previously it just got clipped. However we recommend using single line, brief subtitles.

e The Shortlist now works if your web map uses a basemap that has a spatial reference other than Web
Mercator Auxiliary Sphere (WKID 102100). Previously the Shortlist would hang if the basemap was not in that
projection. (Esri bug number: NIM099707).

e Inthe tabs, we only show a maximum of three lines for long place names. Previously we showed a fourth line
that was partially clipped by the bottom of the tile. Make sure your place names don't exceed three lines
otherwise users won't see the complete name.



Introduction

The Esri Story Map Shortlist®™ story map application template enables you to publish an easy-to-use, attractive
online map application that enables people to discover places of interest in an area. Users browse the places in a
series of tabs next to the map, each showing a particular set of places based on a theme. Places are listed with
images to make the browsing experience fun and attractive. If users see a place in a tab they are interested in,
they can click (or tap) on it and a popup will show its location on the map. Users also click or tap on a place
directly on the map to get the popup about it. As users navigate around the map, the list of places shown in the
tab updates to show them places in the current map extent, so the experience is similar to travelling around in the
real world and discovering new places. So if a user navigates to a particular location, the tabs just show places in
that location. The Shortlist is responsive so the layout automatically changes when it is opened on smaller screens
or in smaller web browser windows.

Tip: You can find some great examples of Shortlists in the gallery on the Story Maps website. Be sure to look at
those to get a feel for what works well for your subject area or target audience

The hardest part of making a Shortlist is the editorial work of choosing the places you want to feature, getting
photos and writing the text. But that's the fun part too! The technical part is fairly straightforward. Here's the
overview of what you do to author and deploy a Shortlist:

e Assemble the set of images that the Shortlist will display for your places, one per place. The Shortlist can
handle any image size but small ones work best: Our recommended size and shape is 280 pixels by 210
pixels. The Shortlist references images via URLs, so you need to put your images onto the web somewhere
so the Shortlist can access them, such as in a folder on any public-facing website or web server. You can
also use any third-party web hosting service, such as iPage™. You just need to be able to get URLs to your
images. You may be able to do this yourself or you may need to have, say, your IT Department do this step
for you depending on the level of access you have.

e Assemble the descriptive information about each place. You might already have information about these
places that you will load into your Shortlist. Or you may need to create the data from scratch. The
Shortlist expects a certain set of fields to exist in your data so it can display your places. The Shortlist
download includes a Samples folder containing ready-to-use data templates you can use. Appendix A in
this document describes the contents of the Samples folder and Appendix B details the Shortlist data
schema.

o Create a web map in ArcGIS Online and load your assembled place data into it as layers. You can use any
ArcGIS Online account to create a Shortlist. Your web map can also include additional supporting layers
that you want to display in your Shortlist.

e The Shortlist download includes the source code for the application. You'll edit the Index.html file in this
set of files to configure your Shortlist. At a minimum you'll edit the line in that file that tells the Shortlist
which web map it should point at. You can optionally change other settings too. No programming is
required: configuration just involves editing a few lines in one text file. If you have web development skills
you can also tweak or customize the Shortlist code to change the look and feel, for example, to reflect
your brand's color scheme.

e Finally, install the Story Map Shortlist source code onto any public-facing website or web server. Like with
getting your images online, you may be able to do this yourself or you may need to have someone with
the appropriate access rights and knowledge do this for you.


http://storymaps.arcgis.com/en/app-list/shortlist/gallery/#s=0&md=storymaps-apps:shortlist
http://www.arcgis.com/home/

1. Assemble your Shortlist places

Your Shortlist can contain one or more tabs. There's no limit to how many tabs you have but we typically
recommend not more than 5 or 6 tabs. If your Shortlist only has one tab it automatically hides the tab control
itself, so users only see the tab controls if they are needed. Each tab in a Shortlist can contain up to 200 features.
For usability and performance reasons we recommend using less than that. So if you have 200 restaurants and
bars in one tab, break them out into two different tabs. But avoid having too few places in a tab: if someone
opens your Shortlist and sees just a handful of places it will look too sparse.

The places in Shortlist are defined using one of the following data formats.
CSV files

e These are Comma Separated Value files, a common text file format for sharing tabular data. These can be
created in any text editor but are normally created by exporting from a program such as a spreadsheet.
Assembling your Shortlist in Excel and then exporting it to a CSV file which you upload into a web map is an
easy way to create your Shortlist data. A CSV file can use Latitude and Longitude fields or street addresses to
geolocate the point features they define. Using street addresses of course will only work for you if your
Shortlist places have street addresses.

You can also add a CSV file located on the web into a web map by referencing it via its URL using the Add >
Add Layer From Web option. This enables you to put a CSV file on the web, reference it from your web map,
and make changes dynamically to the CSV file at its location on the web to update your Shortlist without
having to edit the web map. The easiest way to do this is to put the CSV files on the same server as your
Shortlist application code. If the CSV file you reference via a URL isn't located on the same server as your
Shortlist application, there's an extra configuration step to specify a default proxy for your Shortlist app.

Feature services

These can be published using ArcGIS Online or ArcGIS For Server. This is the easiest way to assemble your data
in ArcGIS for Desktop and then publish it for use in a Shortlist. You can publish feature services from ArcGIS
for Desktop to ArcGIS Online using an ArcGIS subscription account with Publisher or Administrator privileges.
You will normally share your feature services publicly so that anyone can access your Shortlist but you can
also share your services to a restricted audience when your Shortlist isn't intended for public use.

Shapefiles

These can be created in ArcGIS for Desktop, zipped up and uploaded into a web map. Shapefiles have a 254
character limit to text fields though, so it can be hard to make your descriptive text to fit. If you want to use
ArcGlIS for Desktop to assemble your Shortlist data and you can't or don't want to use feature services (see
next point) a better workflow than creating shapefiles may be to assemble your points as geodatabase feature
class layer and then export its attribute table to a CSV file after first adding Lat and Long fields into the table.

The order of the records in the layer's table determines the order in which the places are listed and numbered in
the tab, so you don't need to manually assign a number to each of your places or renumber your places if you add
or remove entries. You do have the option to control the numbering of your Shortlist places via a field value if you
want to: If your data contains a NUMBER field, the Shortlist will use that to number the places and will ignore the
record order of the places. Using a NUMBER field is useful if you want to be able to control the numbering via a
database without having to sort the table. However you will have to manually update the NUMBER field to reflect
additions or deletions of places.



Choose how you want to define your tabs

You have two options for assembling the points of interest for your Shortlist tabs. Which option you use may
depend on what is the easiest way for you to get any existing data into your Shortlist and how you want to
manage and maintain your data.

Option 1: Each tab in your Shortlist is defined by a separate point layer in your web map

This is the easiest way to assemble your data. Each point layer in your web map will be automatically used to
define one of the tabs in your Shortlist. So if you want to have three tabs, each of these tabs will be defined by
a different point layer in your web map.

e The drawing order of these point layers in your web map defines the order in which the tabs appear in
your Shortlist, so the top-most point layer in your map becomes the top-most tab. You can simply reorder
these point layers if you want to change the tab order

e The name of each point layer is used as the name for the corresponding tab. To rename a tab you simply
change the name of its point layer in the web map.

Option 2: All the tabs in your Shortlist are defined by a single point layer.

While using a separate layer to define each tab, Option 1, is an easy way to assemble your Shortlist, it may not
be convenient if the places you want to display are already in a single GIS layer. For example you may have a
point layer containing the complete set of places of interest, differentiated by a field which specifies what
type of place itis. Option 1 may also not be convenient if you want to be able to easily move places between
different tabs because it requires that you delete the place from one layer and add it into another layer. For
these reasons, Option 2 allows you to define all the tabs from a single point layer.

e The Shortlist list looks for a field called TAB_NAME in your layer's attribute table to determine which tab
each place should be displayed in. If you want to move a place from one tab to another you just have to
edit the value of its TAB_NAME.

e The Shortlist uses the values of the TAB_NAME field as the names of the tabs. But you can also override
those values when you configure your Shortlist and supply different names. (See later in this document
for how). This lets you use a token value for the TAB_NAME in your data, like "A", "B", "C", and then
supply the actual names of the tabs when you configure the Shortlist.

e The order in which the values defined in the TAB_NAME field occur in your layer's attribute table
determines the order in which the tabs appear in your Shortlist. You can also override this order when you
configure your Shortlist, which allows you to change the tab order without editing your layer.

e This option to use a single layer can be useful if you want to drive your Shortlist content from a database
especially when using a feature service as the data source for your layer to help automate the process.

The sample datasets that come with the Shortlist download include examples using both of the options above.
The Shortlist automatically determines which of the two options you are using: if it finds a point layer in your web
map with a field called TAB_NAME it assumes you are using Option 2 and it will use that layer to define all the
tabs. If it finds more than one layer with a TAB_NAMIE field it uses the first one in the drawing order.



Assemble your images

Each place shown in your Shortlist is represented by one image. Images are accessed by the Shortlist using URLs,
so the images must be accessible publicly via URLs if your Shortlist will be accessed by the public, which is the
normal configuration. The images can reside on any website or web server.

The image will usually be a photograph of the place but could also be a graphic such as a logo. This can be a good
option if it is hard to find a good photograph of a place like a restaurant or museum.

Each image needs to be in either PNG or JPG format and for best results should be in landscape orientation at a
4:3 aspect ratio. The recommended image size and shape is 280 pixels wide x 210 pixels tall. At this size the
picture not only fills the width of the Shortlist popup but also fits nicely into the width of the display when a
Shortlist is viewed on a smartphone. The minimum size for images is 200 pixels wide by 150 pixels tall, which is
the same 4:3 aspect ratio but a bit smaller:

The recommended image size: The smallest supported image size:

280 pixels wide by 210 pixels tall 200 pixels wise by 150 pixels tall
El Mirasol at Los Arboles X Kings Highway X
Mexican restaurant in very attractive Reimagined hipster diner in the super cool
building with a walled garden patio. Ace Hotel.

Details >>

Details >>

Shortlists look best when all the images are the same size and shape. If you have a mixture of landscape and
portrait images then the tabs may look rather irregular because people will see all those different shapes. It is
best to avoid portrait orientation images if possible because they don't fit nicely into the Shortlist tiles and

popups.

Larger images and different shapes are supported but the Shortlist s are scaled down to fit into the popup. So
even if you use an image that is wider than 280 pixels, it will be scaled down to 280 pixels when it is displayed in
the Shortlist popup. Using larger images can slow down the initial load speed of the Shortlist because all the
images in the first tab are loaded when it is launched, so it pays to resize your images if they are much larger than
the specifications above.

We don't recommend simply pointing at images on third party websites. It is best to make and store your own
copies of images. This enables you to resize and crop them however you like, and also ensures that they are
available. If you reference third party images via URLs it is hard to know when these images are no longer
available and you have no control over their size.



Choose which popup style you want to use in your Shortlist

Before you start assembling the data files containing your places you should choose which popup style you want
to use. The Shortlist offers two different popup styles depending on how much information you want to provide
to your end users. The choice you make applies to all the places in your Shortlist and can't be different for
different tabs. The descriptions below show you which field names in the data files the Shortlist displays.

Popup Style 1: Just a popup (the default style)

The default popup style lets your users access a simple popup with an image and optional fields.

NAME

Cool contemporary restaurant in the SHORT DESC (Optional
Uptown Design District - (Ot )

PIC_URL
Trendy atmosphere with nicely designed DESCRIPTION (Optional)
interior. Can be pricey.
Website WEBSITE (Optional)

Three of these fields are optional (SHORT_DESC, DESCRIPTION and WEBSITE). This means that the fields can
be either be omitted completely from the layer or the fields can be present in the layer but not populated for
one or more features. (The optional fields that are present can vary from layer to layer in your Shortlist). So
for example by omitting the SHORT_DESC field from a layer you can get this popup:

Trio b4 NAME

PIC_URL
Trendy atmosphere with nicely designed DESCRIPTION  (Optional)
interior. Can be pricey.

Website WEBSITE (Optional)

These alternative field names are also supported:
NAME can be TITLE
DESCRIPTION can be CAPTION or DESC1 (DESCRIPTION is too long for use in a shapefile)
PIC_URL can be IMAGE_URL, THUMB_URL or PICTURE



Popup Style 2: Popup and Details panel

With this option the popup contains an image and the SHORT_DESC, plus a 'Details' link that launches a
separate Details panel where you can present full information about the place.

El Mirasol at Los Arboles ¥4 NAME

Mexican restaurant in very attractive
building with a walled garden patio.

Details >>

The Details panel supports up to 5 description fields on the right. Each DESC field contains one paragraph of

SHORT_DESC (Optional)

PIC_URL

text and the right hand side of the panel can be scrolled if the text doesn't fit.

NAME El Mirasol at Los Arboles

There are two El Mirasol restaurants
in town. This is the nicest of the two,
with indoor and outdoor seating in an

PIC URL attractive adobe-style building, with a
- very pleasant walled garden patio.
Specialities of the house include mole
poblano, pollo en pipian (sauce made
" with ground roasted pumpkin seeds),
ADDRESS (Optional) 266 Via Altamira, Palm Springs, CA 54 carne asada. Some vegetarian
92262 (off North Indian Canyon y
Drive) in the Los Arboles Hotel. options too.
HOURS (Optional) Lunch and dinner. Brunch style See their website for more about the
selections.10am-2pm Fri-Sun. menu and their unlisted menu items
WEBSITE (Optional) Website that are available on request if they

have the ingredients.

These alternative field names are also supported:

NAME can be TITLE

DESC1 can be DESCRIPTION or CAPTION
PIC_URL can be IMAGE_URL, THUMB_URL or PICTURE

Popup style 1 is recommended if don't have a lot of info to provide. The Shortlist defaults to use Popup Style 1
unless you change the appropriate setting in the Shortlist configuration. The Details panel in Popup style 2 doesn't
look good if you only use two or three of its fields. Which optional fields appear in the popup and details panel is
automatic: if the optional fields are present and populated in your data, their values will be displayed: you don't

need to tell the Shortlist which optional fields you want to include.

DESC1 (Optional)

DESC2 (Optional)

DESC3 (Optional)

Not used in this example:
DESC4 (Optional)
DESC5 (Optional)



Tip: If you are not sure which popup style to use at this point, choose Popup Style 2 so your data has the full set of
Shortlist fields. Both sets of field names are interchangeable so you can switch between the two styles in the
Shortlist configuration without changing any of your field names.

Tip: You can also include standard HTML formatting in your descriptive text fields for use in either popup style.
For example to get this effect in Popup Style 1, with a ruler line, line breaks and a change in font size and color:

Extraordinary Desserts 4 NAME

PIC_URL
A really amazing bakery and cafe.
; DESCRIPTION
Neighborhood: Little Italy
1430 Union Street between Ash and Beech
Websits WEBSITE

the following HTML tags were included in the DESCRIPTION field:

A really amazing bakery and cafe.<br><hr>Neighborhood: <b>Little Italy</b><br>
<font size="'1"' color="'Grey'><i>1430 Union Street between Ash and Beech</i></font>

Assemble your data layer(s)

The easiest way to assemble the layer(s) for use in the Shortlist with the expected attributes is to use one of the
sample datasets that you'll find in the Samples folder in the Shortlist download.

See Appendix A in this document for a description of what's in the Samples folder.

See Appendix B in this document if you want to see a list of all the fields used in the Shortlist schema. However
this is just provided for reference. You can prepare your Shortlist data just by using the appropriate sample data
from the Samples folder


http://links.esri.com/storymaps/shortlist_template_zip

2. Assemble optional supporting layers

In addition to the point layers that define the tabs in a Shortlist, the web map that your Shortlist uses can
optionally also contain additional layers to show other features on your map such as study area outlines, light rail
routes, etc, or provide additional detail or information.

Your Shortlist will display these layers as-is with one important exception: the Shortlist doesn't support popups
defined for feature layers in your web map. The Shortlist has its own schema for popups, so it doesn't use the
popups defined for features in the web map. However it does allow you to add point, line or polygon feature
layers into your web map that users can click or tab to get information about the features, if they use the Shortlist
schema. These are called clickable supporting layers. Users can also hover their cursor over these features to get
a map tip showing their title.

For example the San Diego Shortlist uses clickable supporting layers to indicate some recommended areas such as
neighborhoods and beaches, trolley routes and stations, and also to show users the ferry routes over San Diego
Bay. The Phoenix Shortlist uses supporting layers to show neighborhoods, parks, the light rail line, and stations on
the light rail route. Another use of a supporting point layer in a Shortlist might be to show a point feature like a
convention center or hotel if your Shortlist is showing places to go near to the location of an event.

These supporting layers are totally optional, so you can have no supporting layers, just one, or multiple. Just like
the layer(s) defining the tab(s) in your Shortlist, each clickable supporting layer has to be based on a CSV file
(which can only be used to define clickable point layers, not lines or polygons), a shapefile, or a feature service.

The names of the supporting line or polygon layers aren't displayed in the Shortlist, so any name can be used for
these layers in your web map.

The easiest way to create clickable supporting layers is to use the samples in the Samples folder as templates to
create any supporting layers you want to display. See Appendix A in this document for a description of what's in
the Samples folder. In addition to point layers, the Samples folder includes line and polygon shapefiles and
geodatabase feature classes.

The fields expected for supporting layers are the same as the fields expected for the point layers that define the
tabs. Note that for clickable supporting layers, the optional NUMBER field is not supported, because these
features aren't numbered. The TAB_NAME field also does not apply. (These and any other fields are ignored if
they are present). Your clickable supporting layers will use the same popup style as the places in your tabs.

In the section of this document about configuring your Shortlist we show you how to tell it which layers in your
web map it handle as being clickable. By default, layers in your web map that don't define tabs are assumed to
not be clickable. If you decide to include a point supporting layer in your Shortlist, we show you we also show you
how to tell the Shortlist that so it knows which of your point layers define tab(s) and which are clickable
supporting layers.


http://storymaps.esri.com/stories/shortlist-sandiego/
http://storymaps.esri.com/stories/shortlist-phoenix/

3. Create your Shortlist web map

Now that you have assembled the point layer(s) to define your Shortlist tab(s) and also assembled any clickable
supporting layers you want to include in your Shortlist, you can add them into a web map. You can create a new
web map for your Shortlist or use an existing one. Either way, you add your assembled layers into the web map.

Add the point layer(s) that define your tabs

In your web map you don't need to specify symbology for the point layer(s) that define your tab. The Shortlist
automatically applies its own built-in numbered marker symbols to the data in the layers. So it doesn't matter
what symbology you apply to these point layers in your web map: it is ignored by the Shortlist. The Shortlist will
not display labels defined in the web map for these point layers.

Similarly in your web map you don't need to configure the popups for these point layers, because the Shortlist
automatically applies its own built-in popup configuration to the data in the layers. So it doesn't matter whether
you configure popups or not for these point layers.

Note: Don't apply a scale visibility range setting to the point layers in your map that define your tabs. If you are
using feature service point layers to define your tabs, the tab won't appear in your Shortlist if it is not drawn on
the map at the scale your Shortlist is initially drawn at. If CSV files and shapefiles have scale visibility range
settings applied to them, the Shortlist ignores those settings and displays the tabs anyway. But in general it is best
to just not set scale visibility ranges for any of these point layers that define tabs.

Optionally, add point, line or polygon layer layers that define clickable supporting layers

Unlike with the point layer(s) that contain the places in your tabs, the symbology you choose for your clickable
supporting layers in your web map is used as-is by the Shortlist. The Shortlist doesn't apply its own symbology to
your supporting layers. So be sure to symbolize your supporting layers the way you want them to appear in the
map. Scale visibility range settings are also taken into account. The Shortlist will display labels defined in the web
map for these layers.

But just like the point layers that contain your places, you don't need to configure the popups for the supporting
layers, because the Shortlist automatically applies its own built-in popup configuration to the data in the layers.

Optionally, add other layers

Other layers in your web map are displayed as-is by the Shortlist, including symbology and scale range settings.
Popups from these layers are not supported in the Shortlist

Choose the initial extent of your map

The initial extent of a web map is simply the spatial extent it shows when it is opened. This extent is whatever
extent was being displayed the last time that the map's author saved the map. When a user opens a Shortlist app,
the first extent they see is the initial extent of the web map. After they've navigated around the map, they can
also return to this initial extent by using the Home button (the house icon) on the map. This provides a nice way
for people to get back to base after they've been somewhere else.

Your initial extent is an important information design choice for your Shortlist application. As the tabs only show
places that are inside the extent that the user is currently viewing in the app, if your initial extent doesn't cover



the entire area of your map that contains your places, people will only see a subset of the places in your map
when they first launch the app and they may not realize that there are other places in the map. So we recommend
that your initial extent cover all of your shortlist points. The user can then browse through the tabs to see all the
places, and they can also zoom in on the map if they want to focus just on what is in one area.

Optionally, add some bookmarks

Your web map can optionally contain some bookmarks. When your web map contains some bookmarks, they
automatically appear in a dropdown menu in the top right hand corner of the Shortlist. By default, this menu is
called 'Zoom' but you can change this name easily (see later in this document for how). For example, for a
Shortlist showing places in a city where you've defined bookmarks for key neighborhoods you might want to
change the Zoom menu to be called Neighborhoods. If you choose not to have any bookmarks, the menu is
automatically hidden in the Shortlist. Your bookmarks should have fairly short names. Bookmarks are listed in the
order in which they appear in your web map.

Bookmarks are an important way for you to guide your users around the areas on the map you want them to look
at. For the San Diego and Palm Springs Shortlists, we treated the bookmarks as part of the set of
recommendations we want to give users. So instead of trying to list every neighborhood in town, we chose the
ones that we wanted to recommend people visit. As described above, we also included a bookmark called
Overview that covers the entire city. We avoided bookmarks for areas that would give the user no places, so that
the user always gets something in their tabs if they visit each of the places in the bookmarks dropdown.

Specify the title and summary for your web map

The Shortlist automatically uses the title of your web map as the title of the Shortlist application and uses the
summary text of your web map as the subtitle in the application. To edit the title and summary of your map in
ArcGIS Online go to the entry for your web map in ArcGIS Online. The other information on the Details page is not
used by the Shortlist.

Take care to make the subtitle for your Shortlist interesting and compelling. Don't just repeat the title of the
Shortlist. For example if your Shortlist is about places to go in a newly revitalized neighborhood of a city, make the
subtitle something that draws the user in, such as "There's lots to do and discover in our downtown so we've
selected some of the best for this map".

Save your map and share it

Save your web map and Share your web map publicly. This is the usual configuration because you want everyone
in the world to see your Shortlist! If you are using feature services in your Shortlist, make sure those are shared
publicly too.

You can also choose to make your Shortlist only be accessible to members of your ArcGIS Online Organization. In
this case people when your Shortlist launches people will have to sign in with their ArcGIS Online account to show
they are members of your ArcGIS Online Organization. This enables you to create a Shortlist containing data that
is not publicly accessible. To do this, share your web map just to your Organization instead of publicly. If you are
using feature services to define your Shortlist you should also share them just to your Organization instead of
publicly.


http://storymaps.esri.com/stories/shortlist-sandiego/
http://storymaps.esri.com/stories/shortlist-palmsprings/

4. Configure your Shortlist

To configure the application, you first download the Shortlist application zip file and save it locally on your
computer so that you can make edits to it. No programming is required. The only one of the Shortlist source code
files you have to edit is index.html. Open this file in the text editor of your choice.

A) Update the application configuration section of the Index.html file

In the Index.html file you'll see the following variables:

var WEBMAP_ID = "88b187a860934d8491bdff591deblela";

var BOOKMARKS_ALIAS = "Zoom";

var COLOR_ORDER = "green,red,blue,purple,black”; // will only use as many colors as you have tabs
var DETAILS_PANEL = "false"; // specifies whether or not popups have a link to a separate Details panel
//

// Specify point feature layers on your map that do NOT define a tab in the Shortlist.

// These point layers will be displayed as supporting layers.

// if there's more than one layer, use the "|" character as delimiter

var POINT_LAYERS_NOT_TO_BE_SHOWN_AS_TABS = "";

//

// Specify supporting feature layers in your map that will be clickable in the Shortlist.

// These layers must use the Shortlist attribute schema for their popups to appear.

// If there's more than one layer, use the "|" character as delimiter

var SUPPORTING_LAYERS_THAT_ARE_CLICKABLE = "";

//

// Location button that locates user (on supported browsers)

var GEOLOCATOR = false;

//

// If the tabs are defined using a single layer, you can optionally use these parameters to

// override the tab order and names defined in that layer without editing the layer.

// If you specify TAB_NAMES: a) all tabs must be included in TAB_NAMES, whether or not

// you want to rename them, b) TAB_ORDER must be specified too,

// c) TAB_NAMES order must correspond with TAB_ORDER. For example:

// var TAB_ORDER = ['Design', 'Fun', 'Food'];

// var TAB_NAMES = [

//  {'Design': 'Design'},

//  {'Fun': 'Activities'},

//  {'Food': 'Snacks'}
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var TAB_ORDER = [];

var TAB_NAMES = [];

//

// Optionally to be able to use the webmap URL parameter, configure here the list of webmap authors
// whose webmaps are allowed to be viewed by this Shortlist deployment

// This is the ArcGIS Online username of the webmap owner (e.g. ["userl"], ["userl", "user2"])
var AUTHORIZED_OWNERS = [];

//

// Edit to use Portal for ArcGIS

var DEFAULT_SHARING_URL = "";
//"http://www.example.com/arcgis/sharing/content/items";

//

// Note: 1If using a proxy server (required for remote CSV access),
// you'll need to provide a valid proxy server url.

var DEFAULT_PROXY_URL = "";

//"http://www.example.com/arcgis/sharing/proxy";


http://links.esri.com/storymaps/shortlist_template_zip

Edit the WEBMAP_ID variable to be the ID of your ArcGIS Online web map. This tells the Shortlist app which
web map to use. For example, our Palm Springs Shortlist web map has this URL:
http://www.arcgis.com/home/webmap/viewer.html?webmap=88b187a860934d8491bdff591d0blela and
the ID of this map is the last part 88b187a860934d8491bdff591d0blela.

Edit the BOOKMARKS_ALIAS variable if you want to specify a different name for the bookmarks menu in the
top right corner of your Shortlist app. By default, this name is "Zoom".

Update the COLOR_ORDER variable to specify a different color ordering for the five colors that the Shortlist
supports for the places in each of your tabs. The default order is green, red, blue, purple, black, so green is
used for the points in the first tab, red for the points in the second tab, etc. If your Shortlist has less than five
tabs, you don't need to specify all the colors. If your Shortlist has more than five tabs, you can either specify
which colors you want to use for each tab, or let them default, in which case, the colors for specified for the
first five tabs will be repeated.

Change the DETAILS_PANEL variable to be "true" if you want your popups to contain a link to the Details
panel (popup style 2 described in the previous section of this document). If you leave this set to "false" your
Shortlist won't use the Details panel and will therefore use popup style 1.

If your web map contains any point feature layers that you want the Shortlist to draw on your map as
clickable or non-clickable supporting layers instead of using them to define tabs, put their layer names into
the POINT_LAYERS_NOT_TO_BE_SHOWN_AS_TABS variable. Any point feature layers in your web map that
are not listed in this variable will be used to define tabs. Use the | character as the separator if you have two
or more layers. For example here is how you would specify this variable if there at there are two point layers
in your web map that you want to be treated as supporting layers instead of defining tabs. The layer names
are case insensitive:

var POINT_LAYERS_NOT_TO_BE_SHOWN_AS_TABS "Light rail stations | Bus stops";

Use the SUPPORTING_LAYERS_THAT_ARE_CLICKABLE variable to list the names of any feature layers in your
map that will be clickable by the user because you have given them the fields that the Shortlist uses for
popups. Don't list the point layers that define your Shortlist tabs in this variable. The only point layers that
you'll list in this variable are those that do not define tabs that you still want users to be able to click to get a
popup. Use the | character as the separator if you have two or more layers.

Set the GEOLOCATOR variable to true if you want your Shortlist to display a geolocator button that users can
click or tap to show their current location on your map. This is off by default because not all Shortlists are
made specifically to be used by people who are inside the area shown on the map. When the button is
enabled in your Shortlist, users can click or tap on it and the Shortlist will center its map on their current
location, as reported by their browser, and display a blue symbol at that location. The blue symbol disappears
after 10 seconds.
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http://www.arcgis.com/home/webmap/viewer.html?webmap=88b187a860934d8491bdff591d0b1e1a

Note that when the user clicks or taps this button they will usually be prompted by their browser to confirm
that they want to share their location with the Shortlist so it can be displayed on the map.

If your Shortlist tabs are defined by a single point layer in your web map, the names of those tabs are defined
by the values in the TAB_NAME field in that layer and the order of those tabs is defined by the order in which
those values occur in the layer. But you can override those names and/or that order using the TAB_ORDER
and TAB_NAMES variable in the application configuration, without having to edit the layer.

For example if your single layer defines three tabs called 'Fun’, 'Food', and 'Design' in that order, you can
override that order:

var TAB_ORDER
var TAB_NAMES

['Design', 'Fun', 'Food'];

[1;

and you can override their names to rename 'Fun' to 'Activities' and 'Food' to 'Snacks'

var TAB_ORDER ['Design', 'Fun', 'Food'];
var TAB_NAMES = [

{'Design': 'Design'},

{'Fun': "Activities'},

{'Food': 'Snacks'}
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Note that if you specify TAB_NAMES you have to specify TAB_ORDER too, even if you don't want to override
the order, and in TAB_NAMES you have to list each of the tabs in the same order as TAB_ORDER even if you
don't want to rename them all. So in the example above, the Design tab has to be listed in TAB_NAMES too.

After you install the Shortlist application (see the next section in this document) you also have the option to
use that one installation for multiple Shortlists by taking advantage of the ability to pass configuration
variables, such as the web map ID, color order, details_panel, etc as parameters in the URL used to call your
Shortlist, overriding the configuration variables specified in the Index.html file. This is convenient because
you can customize and install the Shortlist once, such as with your agency's logo and color scheme, and then
use that one installation for multiple Shortlists. In order for the Shortlist to accept a web map ID via the
webmap URL parameter, the ArcGIS Online account name of the owner of the web map must be specified in
the AUTHORIZED_OWNERS configuration variable in Index.html. You can then launch your Shortlist by
including the ID of the web map owned by an authorized user in the URL:

http://www.example.com/shortlist?WEBMAP=8504932{183c4b8699dc6ba28235e39

You can also include the following additional parameters to override the corresponding configuration
variables:

http://www.example.com/shortlist?WEBMAP=8504932183c4b8699dc6ba28235e398&DETAILS PANEL
=true&GEOLOCATOR=true&COLOR_ORDER=green,red,blue, purple&BOOKMARKS ALIAS=ZOOM&POINT_LAY
ERS_NOT_TO_BE_SHOWN_AS_TABS=Light%20rail%20stations&UPPORTING LAYERS THAT ARE_CLICKAB
LE=Light%20rail%20stations|Light%20rail|Neighborhoods |Parks

If the AUTHORIZED_OWNERS variable is left blank, your Shortlist won't accept a webmap ID via the URL and it
will only use the webmap specified in the WEBMAP_ID variable in the Index.html file. If you specify one or
more authorized owners and a web map ID is not included in the URL that launches your Shortlist, the
Shortlist expects the web map specified in the WEBMAP_ID variable in the Index.html file to be owned by an
owner specified in AUTHORIZED_OWNERS variable.



If your Shortlist web map and data was created using Portal for ArcGIS instead of ArcGIS Online, you have to
specify the DEFAULT_SHARING_URL variable so that the Shortlist can find your portal. Portal for ArcGIS
enables an enterprise to set up its own cloud-based mapping infrastructure, providing the same capabilities as
ArcGIS Online hosted on the enterprise's own servers rather than in Esri's cloud. Web maps created on your
enterprise portal can now be used in a Shortlist, whether your map is accessible just within your enterprise,
publicly, or to signed-in members of your Portal.

To configure a Shortlist to use a web map on a portal specify the DEFAULT_SHARING_URL variable using the

pattern:
http://www.example.com/arcgis/sharing/content/items

So if the home page of your portal is:
http://dept.agency.gov/ourgis/home

then you would set DEFAULT_SHARING_URL to be:
http://dept.agency.gov/ourgis/sharing/content/items

The DEFAULT_PROXY_URL variable enables you to specify a different web proxy for your Shortlist application.
You usually don't need to set this. One scenario where you would set this is if the point layer(s) that define
your tabs are CSV files you have added to your web map by referencing them via URLs and they are not
located on the server on which you are hosting your downloaded Shortlist application code. The easiest way
to deploy a Shortlist using CSV files that you reference via URLs is to put the files you will be referencing on
the same server as your Shortlist application, because in this way you don't need to specify a different
DEFAULT_PROXY_URL variable. Specifying a different proxy enables your Shortlist to reference CSV files by
URLs at other web locations, including sources like Google Docs tables accessed in CSV format. Another
situation where you may have to specify a different proxy is for authentication of certain layers to work
correctly on some older web browsers (like Internet Explorer 9). To specify the correct proxy, use one of the
proxies from https://github.com/Esri/resource-proxy or your own proxy. There's advanced info about proxies
here: https://developers.arcgis.com/javascript/jshelp/ags proxy.html

B) Update the Index.html file to reflect the name of your Shortlist and your agency's identity

In the header section of the index.html file you'll see the following line defining the link in the top right hand
corner of your Shortlist app:

<a id="msLink" tabindex="-1" href="http://storymaps.arcgis.com" target="_blank">A story map</a>

Optionally, if you want to have a different link and target where we currently have 'A story map', modify that
line. We recommend leaving this as it is, but this is up to you. If you do change it, don't use a very long string
because it won't look good on a variety of devices.

You'll also see the following lines that specify the graphic logo that you see in the top right hand corner of
your Shortlist app:

<img tabindex="-1" id="logoImg" src="resources/images/esri-logo-white.png" alt="Esri - Home">

You should update the images/Logo.png file in the source code with your own design. We recommend using
the same size graphic to keep the same layout. Update the URL target as well to where you want the user to
be taken if they click the logo. Changing the logo and the web page it takes users to is an important
customization to make because it adds identity, authority and brand to your story map.


https://github.com/Esri/resource-proxy
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e Inthe head section at the top of the index.html file you should update the TITLE tag:
<title>Shortlist</title>

to match the name of your Shortlist. This will make your Shortlist easier to find via an Internet search.

e In the Facebook sharing section you can optionally update the three meta properties that control how a post
referencing your Shortlist in Facebook appears, to make them specific to your Shortlist.

<!-- Facebook sharing -->

<meta property="og:title" content="Shortlist"/>

<meta property="og:description"” content="This story map was created with the Esri Story Map
Shortlist application."/>

<meta property="og:image" content="resources/images/esri-globe.png">

Save the index.html file.

C) Optionally, make additional customizations to your Shortlist source code

You can of course edit and customize the code in any way you want! That's why we freely provide the complete
code for the application template. It can also be a good way to start learning JavaScript.

You can find some nice examples of customized Shortlists in the Story Maps gallery

e Here's a blog post with some information about how to get started customizing your Shortlist:
http://blogs.esri.com/esri/esri-insider/2013/10/30/creating-and-customizing-a-story-map-from-a-non-giser/

e If you don't want the popup to show the picture of the place (which is how the Shortlist originally worked),
you can set this parameter in the CSS file:

.infoWindowPictureDiv {display:none}


http://storymaps.arcgis.com/en/gallery/#s=30&q=custom&md=storymaps-apps:shortlist
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5. Install your Shortlist

Now you have created your web map and shared it, you are ready to deploy the application by installing the
application's source code, containing the configuration edits you made (see the previous section in this document
and any other customizations) onto a website or web server so it can be accessed.

Note that we don't mean installing the application onto ArcGIS For Server. ArcGIS For Server is a product that
allows organizations to create and serve web services that use GIS data. ArcGIS For Server is not needed in order
to use the Shortlist. By 'web server' we mean the standard web server that you use for your website. This might
be a web server that you or your organization maintains. Or it may simply be a folder on a shared or hosted web
server that you use for your website. In an enterprise situation you might have a system administrator load the
files onto a server. Or if you are an individual or small organization you may simply log in to a system like iPage™
where your website is hosted and copy the files onto your website, in the same way that you or they would put
HTML, PNG, and other files if you were adding a new web page. You could also use a file sharing system like
Dropbox™.

When you copy the contents of the Shortlist application template zip file into a folder on your website or web
server, the location of the application template's Index.html file defines the URL that will be used to access your
shortlist. For example if your website is using a web server like Internet Information Services(lIS) you can create a

folder in its root file structure (C:\inetpub\wwwroot) and copy the contents of the application template zip file
into it. So if you created a folder called:

C:\inetpub\wwwroot\shortlist
and your website's domain is http://www.example.com then the URL of your shortlist will be:
http://www.example.com/shortlist

That's it! Your Shortlist should now be working.



Optionally, add a 'web mapping application' entry into ArcGIS Online to represent your Shortlist

Now you've deployed your Shortlist, we recommend that you add a 'web mapping application' entry, like this one:
http://links.esri.com/storymaps/website/generic_app entry example to represent your application in ArcGIS
Online. You've already got an entry in ArcGIS Online for the web map you are using in your Shortlist, but you don't
have an entry in ArcGIS Online for the application itself.

Although you aren't required to add a 'web mapping application' entry into ArcGIS Online for your Shortlist in
order for it to work, it is highly recommended because a) it enables people who search in ArcGIS Online to
discover and launch your application. Without one of these entries, people can find your web map but won't be
able to find your app, b) it enables Esri staff to discover your application when they look for interesting examples
and creative work by the user community, c) it enables your application to be added into an ArcGIS Online-based
gallery, such as your organization's ArcGIS Online home page, the Living Atlas, or the Story Maps Gallery. These
galleries reference web mapping application entries.

To add a 'web mapping application' entry, go to My Content in ArcGIS Online, and click the Add Item button, and
then in the dialog that appears choose 'The item is an application’, enter the URL of your shortlist and other
information, including tags.

Add Item

Add an item from your computer or reference an item on the Web.

IThe itemis:  An application

(®) Web Mapping | (' Mobile
I http://storymaps.esr.com/stories/shortlist-houston/

Supported Items

Purpose: Ready To Use = API:  JavaScript =

I Houston Shortlist I

{stury map !J Ishurtﬁst x| {Huuston !J {Texas !I

Add tag(s)

ADD ITEM CANCEL

Be sure to include 'story map' and 'shortlist' in the Tags you add so that your entry can be found easily when
people search for examples using those keywords. If you have performed a lot of interesting customization in your
shortlist, add the tags 'custom' and 'customization' too which will help other story map authors find your work.
You should also include tags such as the name of the city, state or province, and country the shortlist covers, plus
additional Tags to reflect the theme or content of the shortlist. This all helps people find your work if they search
ArcGIS Online and makes it show up in the Shortlist search we showed you in the Introduction part of this
document.

After you've added the entry, you can edit it directly in ArcGIS Online to give it a nice looking thumbnail image,
like a little screenshot of the app or one of the pictures from it, and specify credits, etc.

Finally, be sure to share your web mapping application entry publicly.


http://links.esri.com/storymaps/website/generic_app_entry_example

Appendix A: The Samples folder

The \Samples folder in the Shortlist download contains files you can use as template for creating the point layers
that define the tabs in the Shortlist, and optionally, clickable point, line or polygon supporting layers that are also
displayed in your map. Irrespective of whether you use feature services, CSV files, or shapefiles, your layers need
to contain certain attributes that the Shortlist expects, such as an image, title, short description, etc. The easiest
way to assemble your layers so that they contain the correct attributes is to use the appropriate sample file in the
\Samples folder. These files already use the Shortlist attributes, so you can simply fill in your own information in
place of what is there. The Samples are divided into two folders, depending on what style of popup you want to
use.

\samples\Popup_Only
(Use this folder if you'll be using the default style popup, which doesn't have a separate Details panel)

\samples\Popup_and_Details_Panel
(Use this folder if you'll be using the popup style that has a separate details panel showing more information,
accessed via a link on the popup. The files in this folder have the additional attributes that are used in the Details
panel. If you are not sure which popup style you want to use for your Shortlist, use this folder: you can populate as
much of the data as you like and then decide on the popup style later).

For the point data used to define tabs, both folders contains samples for the two options you have for defining the tabs in a Shortlist:
- A "Points" layer used to define a single tab. So if your Shortlist will have three tabs you would make three copies of that Points layer.

- A "Points For Multiple Tabs" layer used to define all the tabs using one layer. This layer contains a Tab_Name field which defines which
tab each place will be displayed in. So if your Shortlist will have three tabs, you would put all of your places into this one layer and specify
the name of the tab that each place will be displayed in using the Tab_Name field.

CSV files

These folders contain ready-made CSV files along with the Excel files used to create each CSV file. There's a separate folder for each of
the geocoding styles supported in ArcGIS Online for CSV files. You can upload CSV files directly into an ArcGIS Online web map by
opening the web map and then using the Add > Add Layer From File option, or put them onto any location on the web and then
reference them via their URL with the Add > Add Layer From Web option. If you want to use Excel to assemble the point data, use the
XLSX file and then save it as CSV file using the Save As command in Excel. You can also use the Points file to create an optional clickable
supporting point layer for your Shortlist which won't be used to define a tab.

\csv_file__lat_long
Points.csv
Points.xlsx
Points_for_multiple_tabs.csv
Points_for_multiple_tabs.xlsx

\csv_file__address__one_field
These files store the street address with which the points are geolocated when the file is uploaded into a web map in one
field: the Address field
Points.csv
Points.xlsx
Points_for_multiple_tabs.csv
Points_for_multiple_tabs.xlsx

\csv_file__address__four_fields
These files store the street addresses with which the points are geolocated when the file is uploaded into a web map in
four fields. In the Popup_Only folder the fields are Address, City, State and Zip. In the Popup_and_Details_Panel folder
the fields are Address2, City, State and Zip because the Address field is used to store the full address of the place that
can appear in the Details panel whereas Address2 is the street part of the address used in geocoding.
Points.csv
Points.x1lsx
Points_for_multiple_tabs.csv
Points_for_multiple_tabs.xlsx



Geodatabase feature classes for creating feature services

This folder contains a geodatabase with four feature classes. You can load these into ArcMap or ArcGIS Pro, publish them as feature
services in ArcGIS Online or ArcGIS Server, and then add those services into an ArcGIS Online web map. The Points and
PointsForMultipleTabs feature class can be used to define the tabs in your Shortlist. The Points, Lines and Polygons feature class can
be used to define optional clickable supporting layers. There's an ArcMap MXD file that references the feature classes that you can
open to prepare your data easily. You can also load that MXD file into an ArcGIS Pro project.

\Geodatabase
Geodatabase (containing Points feature class)
Points
PointsForMultipleTabs
Lines
Polygons
MXD file

Tip: The Points and PointsForMultipleTabs feature classes can also be used if you want to create your Shortlist data in ArcMap or
ArcGIS Pro but without publishing them as feature services. You can use them to generate CSV files from ArcMap which you can
then upload into a web map. You could use Shapefiles instead (see below) but shapefiles impose a 254 character limit on your
text fields. Before you export either point layer's attribute table to a CSV file, you will need to add Lat and Long fields to the table
(use the Double field type letting scale and precision default) and populate their values using the Calculate Geometry command in
the ArcMap table window.

Shapefiles

This folder contains four shapefiles with four feature classes. You can load these into ArcMap or ArcGIS Pro, edit them, and then add
them into an ArcGIS Online web map by first zipping them up into a zip file (one zip file per shapefile) and then upload the zip file
directly into an ArcGIS Online web map by opening the web map and then using the Add > Add Layer From File command. The Points
and PointsForMultipleTabs shapefiles can be used to define the tabs in your Shortlist. The Points, Lines and Polygons shapefiles can be
used to define optional clickable supporting layers. There's an ArcMap MXD file that references the shapefiles that you can open to
prepare your data easily. You can also load that MXD file into an ArcGIS Pro project.

\Shapefiles
Points
PointsForMultipleTabs
Lines
Polygons
MXD file



Appendix B: The Shortlist data schema

Here is a description of each of the fields that the Shortlist application looks for. These fields are in addition to the
standard ones used by the file the layer is based on, such Lat, Long or Address fields in the case of CSV files, and
the standard fields like FID, Shape or ObjectID used by shapefiles and feature services, which we don't list here.

The field names have to match the names in English shown below. Field names are not case sensitive even though
they are listed in upper case here. The fields can be in any order. Additional fields not listed below are allowed to
be present in the data but are ignored by the application. Optional fields can either be omitted from the layer
completely or be present but not populated for some or all features. So for example if a URL isn't specified for the
WEBSITE field for one or more features in a layer, the Website link will automatically not be present when
someone opens one of those features.

If the Shortlist finds multiple fields in your layer that match a field it is looking for, it will use the right-most field in
left-to-right field order. So if your layer contains PIC_URL and THUMB_URL fields, both of which are supported
field names for the field containing the URLs to the Shortlist images, it will use THUMB_URL if that is to the right
of the PIC_URL field in the table. HTML tags can be used in the descriptive text fields to define formatting.

REQUIRED FIELDS:

NAME A text field containing the name of the place. This appears below the photo in the tile
representing the feature in the tab, as a map tip when the user hovers their cursor over the
place on the map, in the title bar of the popup, and in the title bar of the optional Details
panel. The main constraint on name length is that it has to fit into the available space
underneath the photo tile in the tab which is limited to a three line wrap around. Any text
that doesn't fit into the available three lines is clipped. This field must be present and must be
populated for each feature. (This field can also be called TITLE).

PIC_URL A text field containing the full URL of an image showing or representing the place. This graphic
appears in the tabs to the left of the map, in the popup and, if you choose to use one, in the
Details panel. This field must be present and must be populated for each feature. (This field
can also be called PICTURE, THUMB_URL or IMAGE_URL).

REQUIRED FIELD IF YOU WILL BE DEFINING YOUR TABS FROM A SINGLE LAYER

TAB_NAME A text field containing the name of the tab that each place defined in your layer will be
displayed in. The order of these values in the layer's attribute table is used to determine the
tab order. The tab names and the tab ordering defined by this field can be overridden in the
Shortlist configuration so that they can be changed without editing the data in the layer.

OPTIONAL FIELDS IF YOU WILL BE USING POPUP STYLE 1 (THE DEFAULT POPUP STYLE)

SHORT_DESC A text field containing a description of the place that users see when they open the popup for
a place. This is best kept short, and is easiest to read if it isn't a complete sentences.

DESCRIPTION A field containing one paragraph of descriptive text. (This field can also be called CAPTION or
DESC1, for example if you are using a shapefile, as DESCRIPTION is too long to be used as a
field name in a shapefile.)

WEBSITE Text field containing the full URL of a website or web page about the place. When the user
follows this link, it gets launched in a new tab in their web browser.



OPTIONAL FIELDS IF YOU WILL BE USING POPUP STYLE 2 (POPUP WITH DETAILS PANEL)

SHORT _DESC A text field containing a description of the place that users see when they open the popup for
a place. This is best kept short, and is easiest to read if it isn't a complete sentences. It is not
shown in the Details panel (so people don't see the same text twice).

DESC1 - DESC5 These are five optional text fields containing one paragraph of description. They appear in the
optional Details panel. You can populate some of these fields or all of them. Although these
fields are all optional you will want to populate at least the DESC1 field if you are using the
Details panel because the whole point of the Details panel is to give people more information
and it will look bare without at least some text. The field name DESCRIPTION or CAPTION can
also be used instead of DESC1. So you can switch between Popup Style 1 and Popup Style 2
without changing the name of this field.

ADDRESS A text field containing the address of the place. This doesn't have to be an actual street
address: it can contain any text you like. Don't put too much text in this field: In the Details
panel, the left hand column isn't scrollable so if the user is viewing the Shortlist in a small
browser window, the bottom of the left hand column may be clipped.

HOURS A text field containing the opening hours of the place or any other text about a place. Don't
put too much text in this field: In the Details panel, the left hand column isn't scrollable so if
the user is viewing the Shortlist in a small browser window, the bottom of the left hand
column may be clipped.

WEBSITE A text field containing the full URL of a website or web page about the place. When the user
follows this link, it gets launched in a new tab in their web browser.

OPTIONAL NUMBER FIELD

By default the places in a Shortlist tab are automatically numbered based on the record order of the attribute
table of the point layer that defines the tab. This makes it easy to maintain Shortlist data because if you add
or delete one or more places, the places get automatically renumbered sequentially. To change the numeric
order of the places in a tab you can change the order of the records in your table to get the order you want.
For example if you want certain places to come first in your tab you could move those records to the top of
your table by adding a numeric field into the table, editing its values to get the numeric order you want, and
then sorting the table on that field. You can do that in Excel if you are using CSV files or do it in ArcGIS for
Desktop as you create your shapefiles or feature services.

If your attribute table contains an integer field called NUMBER, the Shortlist will use the value of that field for
each record to number the places in your tab. This enables you to control the number for each place via a
field and override the record order. However you will have to manually update the NUMBER field to reflect
additions or deletions of places. The value of NUMBER should be an integer between 1 and 200. Using a
NUMBER field is useful if you want to be able to control the numbering via a field without having to sort the
table.

If you are using CSV files or feature services for your layers, all the descriptive text fields (SHORT_DESC,
DESCRIPTION, DESC1-DESC5, ADDRESS, HOURS) can contain text with an unlimited number of characters. If you
are using shapefiles text fields have a 254 character limit.

Tip: if you want to create Shortlist content that is compatible with the older versions of the Shortlist application
prior to the current version (1.4) use these field name alternatives: TITLE, IMAGE_URL, DESC1.



